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Shareware
Cheque is Shareware. It is not free and not in the public domain. If you choose to use it, please register 

by sending an interesting postcard (you read it right) to:
Kaleidos Software
Edward G. Harp
P.O. Box 429390
Cintinnati, OH 45242-9390

If Cheque generates user interest; that is, if people actually use it; I will support it with bug fixes and 
new features (heck, I use it myself so you can at least count on bug fixes). Please report any bugs. 
Include a description of what happened and what Macintosh model and System Software version (e.g. 
6.0.7) you are using. Users are also encouraged to suggest improvements and new features.

Distribution
Users and user groups may distribute Cheque. For-profit organizations may not distribute Cheque 

without written permission from the author. Online services such as America Online, GEnie and 

Compuserve may distribute Cheque.

You should not have to pay anyone anything beyond downloading charges for a copy of Cheque. If you 
did pay someone for a disk containing Cheque, please let me know.

About Cheque
Cheque is a personal finance application. Its primary purpose is to track your finances via your checking 

and savings accounts.

Cheque was originally intended to be a commercial product, but due to the market forces that be, it is 
brought to you at the low, low price of one cool postcard (I like the ones that say “Greetings from…”).

Cheque is intended to run on any Macintosh model from the Plus forward using System 6.0.5 or greater. 
If Cheque fails to work properly under these conditions, please let me know.

About This Document
This document is divided into the following major sections:

Cheque Documents: a description of what Cheque documents contain and how they are organized.
Checking Account Tutorial: a step-by-step description of the maintenance of a checking or savings 
account. This section also describes the creation of Cheque documents and the use of many of Cheque’s 
features.
Categories: how to categorize your finances. 
Reports: how to create reports from Cheque documents.
Printing: how to print from Cheque.
Dragging Items: a convenient way to copy information.

It is recommended that you read through this entire document before using Cheque.



Cheque Documents
Cheque documents consist of any number of accounts. There are several types of accounts:

• Address
• Cash
• Category/Budget
• Checking/Savings
• Recurring Entry (checking transactions)

Each account consists of any number of items (records). Each type of account contains particular items. 
For example, Address account items contain a name and address, while Checking/Savings account items 
contain transactions such as deposits and checks.

The number of documents, accounts and items are limited only by memory and disk space available.

Throughout Cheque, an account’s type is represented by one of the following icons:

Addresses

Cash

Categories/Budget

Checking/Savings

Recurring Entry

Checking Account Tutorial
The following is a step-by-step description of how to use Cheque to maintain a checking/savings 

account. Here, I make the assumption that you are familiar with standard Macintosh concepts. This 

tutorial explains how to create a Cheque document and a checking account. It also explains how to 

accurately track the account.

Creating a new document
To create a new Cheque document:
• Select New… in the File menu.
• When the file naming dialog appears, select the file’s destination, type in a name for the file.
• Click the Save button to create the document.



Once you have created the document, an empty document window will appear. Note that the title of the 
window is the name you gave the document. Note also that there is a document icon to the left of the 
title.

Creating an account
Next, create an account to hold transactions for your checking account.

• Select New… from the Account menu. A new account dialog will appear:



• Select the type of account to create by clicking on the appropriate icon. In this case the 
Checking/Savings icon and radio button should be selected.
• Type in the name of the account and a comment (optional).
• Click the Create Account button to create the account.

A row will appear in the document window representing the new account.

Starting a checking account
In order to get the checking account you have just created caught up with the real world one, you will 
have to do two things:

• Determine the balance of the account as of the last statement you received and enter it.
• Enter all transactions that have occurred since the last statement.

Entering the initial balance
Once you have determined that balance of the checking account as of the last statement, you need to 
enter a transaction to reflect that balance:

• Select the checking account in the document window by clicking on it.
• Select New from the Items menu. An item entry window will appear.
• Note the Type: pop-up menu in the upper left corner of the window. This is used to select the type of 
transaction you want to enter. Use the pop-up menu to select a deposit transaction:



Note that we are entering a deposit transaction for the initial balance of the account.
• The item entry window will change to reflect the kind of transaction you are entering:

• Press the Tab key once to move the caret over to the Date field. Enter the date of the last statement you 
received for the checking account in the form mm/dd/yy.
• Press the Tab key again to move the caret to the Description field (Desc.). Enter a description of the 
transaction such as “Beginning Balance.”
• Use the Tab key to move the caret to the Amount field (two key presses). Enter the balance of the 
checking account.
• Click the Cleared check box at the bottom of the window. This transaction will not have to be cleared.

• At this point all of the necessary fields have been entered for this transaction.
• Select Accept in the Items menu. This will actually enter the item into the account.

Entering other transactions
The next step is to enter all the transactions that have occurred since the last statement. Gather together 
all deposit slips, ATM receipts, the written check register etc.



Note that in order for your Cheque checking account to be accurate you must enter all the transactions 
that have occurred. If there are any you missed, the Cheque checking account will accurately reflect 
your real world checking account until your next statement arrives. It is important to learn to save all 
ATM receipts and to write down or enter all checks, deposits, or other transactions that affect your 
checking account. It can be done!

Before entering the transactions, here’s another Cheque feature that you might find useful:

• With the item entry window in front, (we left it there above) select Show Entry Tools in the Items 
menu. A floating palette of icon buttons will appear:

Click this to cancel a new 
item you are entering

Click this to delete the 
currently displayed item

Click this to display the next 
item in the account

Click this to accept the currently 
displayed item (either a new one or an 

edited one)

Click this to display a new item

Click this to display the 
previous item in the account

Click this to display a Find dialog 
for finding items in the account

This palette contains buttons that are analogs of most of the items in the Items menu. Cheque will 
remember that you opened the palette and will display it whenever an item entry window is opened. 
Note that some buttons are grayed and cannot be clicked. Under the right conditions, they will change 
appearance.

Now, back to entering the items:

• Begin entering the transactions since your last statement by clicking the New button (or selecting New 
from the Items menu) to create a new item. Click the Accept button to finish entering an item.
• Enter the transactions as above by selecting the transaction type, then filling in the fields as 
appropriate. Note the following tips on determining different which transaction type to use:

charge: This type is intended for charges debited to your account such as service charges. Typically these 
transactions will be entered when you balance your account when a new statement arrives.

check: This type is used to enter checks.

deposit: Any money deposited in your account other than interest payments should be entered as this type.

interest: Use this transaction type for interest payments made to your account.

withdrawal: This transaction type is intended for ATM (automated teller machine) withdrawals and withdrawals at 
your bank where you do not write a check.

Transactions are credited or debited to an account by the nature of the type of transaction, not by the 



entering of a negative number. Transactions that are credited are: deposit, interest and transfer from. 
Transactions that are debited are: charge, check, transfer to and withdrawal. You need not ever enter a 
negative number into the Amount field.

Note that the transactions since the last statement should be entered with the Cleared check box not 
checked. They will be cleared when the next statement arrives.

Other item entry options
You can change the way that item entry behaves somewhat:

• With either one of an account’s window up front or with the account selected in the document window, 
select Account Info in the Account menu. An account info window will appear:

Edit the name and 
comment for the 

account here

Use this pop-up to set 
the default type of 

new items

Click this check box if 
you want new items to 

use the type of the 
last entry you created

Click these check 
boxes if you want 

check item numbers 
and the date to be 

automatically entered

These radio buttons 
determine what is 

displayed after you 
accept a new item

All of the settings in the New Items box in the info window affect how Cheque behaves when you enter 
new items.

You can open an account info window for any account regardless of its type. The settings available for 
new item behavior vary by account type.

The register window
Next, let’s take a look at all of the work you have done. A register window can be opened for each 
account regardless of the type. Register windows display all of the items in an account in a register-like 
list.

• With either one of the checking account’s windows in front or the account selected in document 
window when it is in front, select Register in the Account menu. A checking register window will 
appear:



The account's balance is 
displayed here

The balance of all cleared 
items is displayed here

Click this icon to select 
between two row heights

Click in this column to mark 
items as cleared. Click in 
other columns to select or 

drag an item

Note the name of the 
account here

Selected items appear 
like this

Note the account balances displayed in the register window. The account’s current balance is displayed 
on the left and the balance of cleared items is displayed on the right. The balance of cleared items is the 
balance of all items that have been cleared, and therefore should always reflect the balance as of the last 
statement received.

Items can be edited somewhat from register windows:

• Select items by clicking on them. Only one item can be selected at one time. You can also use the up 
and down arrow keys to select items.
• To delete an item, select it then select Delete from the Items menu. You will be asked to confirm your 
desire to delete the item.
• To edit an item, select it then select Edit in the Items menu or double-click on the item. The item will 
then be displayed in an item entry window so that you can edit it.

Save your work
After you have finished making changes to the Cheque document, select Save in the File menu to save it 
to disk. This should also be done at regular intervals when you are entering a large number of items to 
prevent losing the changes due to a power outage or other sudden interruption.

Having to save changes made to Cheque documents may seem like an unnecessary step, but it does 
provide the opportunity to not save them if you make a mistake or change your mind.

Entering new transactions
As the days roll by and you use your checking account, be sure to enter all transactions into the Cheque 
checking account. I prefer to sit down once a week with all ATM receipts (I keep them in my wallet) and 
the written check register. I also enter all checks when I pay bills.

This all may seem like a bother, but it is the only reliable way to know how much money you have at 
any given time. It is also the best way to determine how much money you have spent.

Balancing the checking account
When the next checking account statement arrives from the bank, it is time to balance the account:



• Open the Cheque document containing the checking account and display the register window.
• One at a time, go through all transactions on the statement and mark them as cleared by clicking in √ 
column for that item:

I also like to put a mark next to the transaction on the statement to indicate that I have dealt with it. Note 
that the balance of cleared items will change as you clear items.

• Check amounts as you go to be sure you entered them correctly and edit them if necessary. 
• If you find transactions on the statement that are not entered into the Cheque account, enter them at 
this time. Usually this will only mean transactions such as service charges. There is always the 
possibility that the bank will make a mistake, but if a transaction is there on the statement, chances are it 
is a real one.
• Once you are finished, the balance of cleared items displayed in the register window should be the 
same as the balance at the end of the new statement. If it is not, then there is either one or more missing 
transactions or an error somewhere. I prefer to find the mistake (and always do), but it is possible to 
enter a cleared deposit or withdrawal transaction to force the account into balance. Some checking 
programs make this too easy. It is not necessary and leaves you with inaccurate information!
• Save the document after balancing.

Categories
Another type of account available in Cheque is the category/budget account. A category/budget account 

consists of items that allow you to categorize where your money is going and where it came from.

Creating a category/budget account
• With a Cheque document window open and in front select New… from the Account menu.
• Create the category/budget account as you did the checking/savings account above, except this time 
click the Category/Budget radio button and give the account a name such as “Budget”:

Before entering categories, it is a good idea to consider a setting for the account:

• Select the category account in the document window and select Account Info in the Account menu. An 
account info window will appear:



• Note the budget period pop-up menu. There are three budget periods to select from:

The budget period is the period of time that a budget amount entered for a category is applied to. That is, 
if you budget $80.00 per month for groceries, the budget amount would be $80.00 for a month budget 
period, $240.00 for a quarter budget period (a quarter being three months) and so on. Normally you will 
probably use a budget period of one month.

• With the category/budget account selected in the document window or with the account info window 
in front, select New from the Items menu to begin entering categories. A category item entry window 
will appear:

There are two different types of categories that can be entered: expense and income. Expense categories 
are for money you spend and income categories are for money you deposit. In the Budget field, enter 
the amount you wish to budget for the budget period selected in the account info window. Remember it 
is not necessary to enter negative numbers. Cheque makes the appropriate numbers (i.e. expenses) 
negative for you.

How you categorize your finances is up to you. Just remember to balance the categories between 
expenses and income. You need to know how much is coming and going to get an idea of how you 



spend your money.

Here’s an example set of categories in a category account register window:

The budget period selected 
in the account info window 

is displayed here

Total expenses and income are 
displayed here

The sum of expenses and 
income is displayed here

Note the expense and income totals at the top right of the window and the sum of expenses and income 
at the bottom right. In order to have a balanced budget, your expenses cannot be greater than your 
income. In this example there is $205.00 left, which could either be put in a misc. category or maybe put 
in savings. I personally like to have something of a “buffer” for those unplanned expenses that always 
crop up every month.

Using categories
Once you have created a list of categories, the next step is to use them in checking/savings account 
transactions:

In checking/savings entry windows there are two fields at the bottom used to categorize the transaction:

Enter the amount to apply to 
the category in this field

Enter the name of the category 
in this field



Entering these fields can be arduous, so there are short cuts to make it easier:

• You can quickly copy the Amount field to the Apply… field by tabbing to the Apply… field and 
selecting Paste Amount in the Edit menu.

• To paste a category, tab to the To field and select Paste Category Name… in the Edit menu. A dialog 
for selecting a category will appear:

• Use the pop-up menu at the top of the dialog to select the category/budget account, select a category by 
clicking on it and click the Paste button to paste the category.

It is a good idea to paste category names rather than type them. This ensures that the name will not be 
misspelled.

In a single checking/savings transaction, amounts can also be applied to multiple categories:

• Enter the Apply… and To fields as above.
• Click the Add button at the left bottom of the window to add the amount and category to the list below 
the Apply… and To fields:

Any number of amount/category combinations can be added to the list.
• An amount/category can be removed from the list by selecting it and clicking the Remove button to the 



left of the list.

Reports
Cheque can generate reports based on either a checking/savings or category account:

• With a checking/savings or category account selected in a document window or with an account’s 
window in front select New Checking (or Category) Report… in the Account menu. A new report dialog 
will appear:

Enter the beginning and ending 
dates for the report here

Check the check boxes of 
transaction types you want 
included in the report here

Enter other criteria for 
the report here

Click this button to 
create the report

• Once you click the Create Report button, the report will appear in a register-like window:

The beginning and ending dates 
for the report a displayed here

The totals for the report 
are displayed here



Note that Cheque reports are “live.” That is, if the items used in the report change, the report 
automatically recalculates itself.

Printing
Register and report windows can be printed in Cheque. With one of these windows in front, select 

Print… in the File menu and proceed as with any other Macintosh printing.

Dragging Items
You may have noticed by now that items in register windows can be dragged. The reason for this is to 

provide an easy way to copy items. An example of this is the copying of a category into a To field in a 

checking account item entry window:

Note that the cursor 
changes to a 

downward arrow 
when the item can be 

dropped

The items of several types of accounts can be dropped onto checking/savings account item entry 
windows: category, recurring entry and addresses.

Checking account items can be dropped on recurring entry item entry windows to copy them. This is 
useful when building a list of recurring entries.

Items can also be dropped on accounts in a document window. An item entry window for the account 
dropped on will be opened and the item copied as appropriate.


